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Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.

4. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.

5. Renesas Electronics products are classified according to the following two quality grades: "Standard" and "High Quality". The intended applications for
each Renesas Electronics product depends on the product's quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home
electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system;
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims
any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is
inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.

6. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, "General Notes for
Handling and Using Semiconductor Devices" in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury,
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

10. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.

(Rev.4.0-1 November 2017)

Corporate Headquarters Contact Information

TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:
www.renesas.com www.renesas.com/contact/
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LS|, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi. (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSI is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-
evaluation test for the given product.



Disclaimer

By using this Renesas Solution Starter Kit (RSSK), the user accepts the following terms:

The RSSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSSK is
assumed by the User. The RSSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSSK,
even if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSSK product:

This Renesas Solution Starter Kit is only intended for use in a laboratory environment under ambient temperature and
humidity conditions. A safe separation distance should be used between this and any sensitive equipment. Its use
outside the laboratory, classroom, study area or similar such area invalidates conformity with the protection
requirements of the Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
o power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 10m of the product when in use.
e The useris advised to take ESD precautions when handling the equipment.

The Renesas Solution Starter Kit does not represent an ideal reference design for an end product and does not fulfil
the regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use the e? studio IDE to develop
and debug software for the RSSK platform. It is intended for users designing sample code on the RSSK

platform, using the many different incorporated peripheral devices.

The manual comprises of step-by-step instructions to load and debug a project in e? studio, but does not
intend to be a complete guide to software development on the RSSK platform. Further details regarding
operating the RX23W microcontroller may be found in the RX23W Group Hardware Manual and within the
provided sample code. The setup procedure for the RSSK Web installer is described in the Quick Start Guide.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur
within the body of the text, at the end of each section, and in the Usage Notes section.

In this manual, the display may differ slightly from screen shots. There is no problem in reading this manual.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to
the text of the manual for details.

The following documents apply to the RX23W Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web

site.

Document Type Description Document Title Document No.
User’s Manual Describes the technical details of the RSSK Renesas Solution Starter Kit R20UT4446EG
hardware. for RX23W User’s Manual
Tutorial Manual Provides a guide to setting up RSSK Renesas Solution Starter Kit R20UT4447EG
environment, running sample code and for RX23W Tutorial Manual

debugging programs.
Quick Start Guide Provides simple instructions to setup the RSSK | Renesas Solution Starter Kit R20UT4448EG
and run the first sample, on a single A4 sheet. for RX23W Quick Start Guide
Smart Configurator Provides a guide to code generation and Renesas Solution Starter Kit R20UT4449EG
Tutorial importing into the e? studio IDE. for RX23W Smart Configurator
Tutorial Manual
Schematics Full detail circuit schematics of the RSSK. Renesas Solution Starter Kit R20UT4445EG
for RX23W Schematics
Hardware Manual Provides technical details of the RX23W RX23W Group User’'s Manual: | RO1UH0823EJ

microcontroller.

Hardware




2. List of Abbreviations and Acronyms

Abbreviation Full Form
ADC Analog-to-Digital Converter
API Application Programming Interface
bps bits per second
CMT Compare Match Timer
COM COMmunications port referring to PC serial port
CPU Central Processing Unit
E1/E2 Lite Renesas On-chip Debugging Emulator
GUI Graphical User Interface
IDE Integrated Development Environment
IRQ Interrupt Request
LCD Liquid Crystal Display
LED Light Emitting Diode
LSB Least Significant Bit
LVD Low Voltage Detect
MCU Micro-controller Unit
MSB Most Significant Bit
PC Personal Computer
PLL Phase-locked Loop
Pmod™ Thi§ is a Digilent Pmod™ qupatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface Specification
PSU Power Supply Unit
RAM Random Access Memory
ROM Read Only Memory
RSSK Renesas Solution Starter Kit
RTC Real Time Clock
SCI Serial Communications Interface
SPI Serial Peripheral Interface
TFT Thin Film Transistor
UART Universal Asynchronous Receiver/Transmitter
uUSB Universal Serial Bus
WDT Watchdog Timer

All trademarks and registered trademarks are the property of their respective owners.


https://reference.digilentinc.com/reference/pmod/specification?redirect=1
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LENESAS

1. Overview

1.1 Purpose

This RSSK is an evaluation tool for Renesas microcontrollers. This manual describes how to get the RSSK

tutorial started, and basic debugging operations.

1.2 Features

This RSSK provides an evaluation of the following features:
« Renesas microcontroller programming

« User code debugging
o User circuitry such as switches, LEDs and a potentiometer

Through the provided set of sample applications.

The RSSK board contains all the circuitry required for microcontroller operation.

R20UT4447EG0101 Rev. 1.01
Mar.31.20 RENESAS
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Renesas Solution Starter Kit for RX23W 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, the most common questions asked about using a Renesas
Solution Starter Kit (RSSK). The tutorials help explain the following:

e How do | compile, link, download and run a simple program on the RSSK?
e How do | build an embedded application?
e How do | use Renesas’ tools?

Files referred to in this manual are installed using the project generator as you work through the tutorials. The
tutorial examples in this manual assume that installation procedures described in the RSSK Quick Start Guide
have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

Due to the project generator, it is possible that line numbers for source code illustrated in this document do not
match exactly with that in the actual source files. It is also possible that the source address of instructions
illustrated in this manual differ from those in user code compiled from the same source. These differences are
minor, and do not affect the functionality of the sample code nor the validity of this manual.

These tutorials are designed to show you how to use the RSSK and are not intended as a comprehensive introduction
to e? studio, the compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more in-
depth information.

21 Smart Configurator Plugin

The Smart Configurator plugin for the RX23W has been used to generate the sample code discussed in this
document. Smart Configurator for e? studio is a plugin tool for generating template ‘C’ source code and
project settings for the RX23W. When using Smart Configurator, it supports the user with a visual way of
configuring the target device, clocks, software components, hardware resources and interrupts for the project;
thereby bypassing the need, in most cases, to refer to sections of the Hardware Manual.

Once the user has configured the project, the ‘Smart Configurator’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are name ‘Config_xxx.h’,
‘Config_xxx.c’, and ‘Config_xxx_user.c’, where xxx’ is an acronym for the relevant MCU feature, for example
‘CMT’. Within these code modules, the user is then free to add custom code to meet their specific
requirement. However, these files require custom code to be added between the following comment
delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Smart Configurator will locate these comment delimiters, and preserve any custom code inside the delimiters
on subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-
visit Smart Configurator to change any MCU operating parameters.

Note: If code is added outside the above user code area, it will be lost if code generation is executed again
with Smart Configurator.

In this RSSK sample project, only some functions are used.
For other useful features, refer to the https://www.renesas.com/smart-configurator.

R20UT4447EG0101 Rev. 1.01 Page 9 of 23
Mar.31.20 RENESAS
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Renesas Solution Starter Kit for RX23W 3. Tutorial Project Workspace

3. Tutorial Project Workspace

3.1 Introduction

e? studio is an open source integrated development tool that allows the user to write, compile, program and
debug a software product on many of the Renesas microcontrollers.

3.2 Connecting the Debugger
For this tutorial, the E2 Lite debugger will provide power to the RSSK, no external power supply is required.

The Quick Start Guide provided with the Renesas Solution Starter Kit board gives detailed instructions on how
to connect the E2 Lite to the host computer. The following assumes that the steps in the Quick Start Guide
have been followed and the E2 Lite drivers have been installed.

e Fit the PMOD LCD display to the PMOD2 connector on the board. Ensure all the pins of the connector
are correctly inserted in the socket.

e Connect the E2 Lite Debugger to a free USB port on your computer.

e Connect the E2 Lite Debugger to the target hardware ensuring that it is plugged into the connector
marked ‘E1/E2 Lite’.

3.3 Starting e? studio and Importing Sample Code

To use the program, start e?studio:

Windows™ 8.1: From Apps View @ click ‘Renesas Electronics e2studio > e2 studio icon
Windows™ 10: Start Menu > All Apps > Renesas Electronics e2studio > e2 studio

« Start e? studio by selecting it from the
Windows™ Start Menu. The first dialog box | | select a directory as workspace
to appear Wi” be the Workspace Launcher e studio uses the workspace directory to store its preferences and development artifacts.

e Click ‘Browse’ and select a suitable location T | \Workspace -

to store your workspace, using the ‘Make
New Folder’ option as necessary. Click
‘Launch’.

[[] Use this as the default and do not ask again

Launch Cancel

e The e? studio Welcome splash screen will
appear. Click the ‘Workbench’ arrow button
on the far right (circled in the screenshot
opposite).

R20UT4447EG0101 Rev. 1.01 :{EN ESNS Page 10 of 23
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Renesas Solution Starter Kit for RX23W

3. Tutorial Project Workspace

e Once the environment has initialized, right
click in the ‘Project Explorer’ window and
select ‘Import...°

B ProjectExplorer 52 | B ¥ = O

New ¥
Show In Alt+5hift+W »
Copy Crl+C

Copy Qualified Name

2 Paste Ctrl+V
Delete Delete
ix Import.
Ly Export..
Refresh F5

e The Import dialog box will be shown.
Expand the ‘General’ folder icon, and select
‘Existing Projects into Workspace’, then
click ‘Next'.

e’ Import

Select

Create new projects from an archive file or directory.

Select an import wizard:

type filter text

"o Rt

v [= General -

& Archive File
=% Existing Projects into Workspace
[} File System
i HEW Project
[T] Preferences
[} Projects from Folder or Archive
& Rename & Import Existing C/C++ Project into Workspace
e Renesas CCRX project conversion to Renesas GCC RX
Ta# Renesas CS+ Project for CATBKOR/CATEKD
e Renesas CS+ Project for CC-RX and CC-RL
e Renesas GitHub Amazon FreeRTOS Project

= C/C++

= Code Generator

@

< Back MNext = Finizh Cancel

e The Import dialog box will allow you to
specify a project to import. Click the
‘Browse’ button and locate the following
directory:

C:\Renesas\Workspace\RSSK\RSSKRX23W

e Ensure that the ‘Copy projects into
workspace’ option is ticked, and then click
‘Finish’.

Import Projects

(O Select archive file:

Projects:

e’ Import a X

Select a directory to search for existing Eclipse projects.

(@) Select roct directory:

=
o,

2

C:\Renesas\Workspace\RSSK\RSSKRX23W ~

Erowse.

Browse...

Application (C:
Async_Serial (C:\Renesas\Workspace\RSSK\RSSKRXZIWNAsync_Serial)

Low_Power_Mode (C:\Renesas\Workspace\RSSK\RSSKRX23WALow_Power_Mode)

RTC (C\Renesas\Workspace\RSSK\RSSKRX23W\RTC)

System_Bootl oader (C:\Renesas\Workspace\RSSK\RSSKRX23W\ System_BootLoader)
System_Bootloader_Application (C:\Renesas\Waorkspace\RSSK\RSSKRX23W\System_Bootl oader_Application)
Sytem_Input_
Timer_PWM (C:\Renesas\Workspace\RSSK\RSSKRX23WN Timer_PWIM)
Touch (C:\Renesas\Workspace\ RSSK\RSSKRX2 W Touch)

Tutorial (C:\Renesas\Workspace\ RSSK\RSSKRX23W Tutorial)

RSSK\RSSKRY2IWLA,

Select All
Deselect All

Refresh

Capture (CA\Renesas\ Workspace\RSSKARSSKRX23W Sytem _Input_Capture)

Options

Working sets

@

[15earch for nested projects
Copy projects inte workspace
[ Hide projects that already exist in the workspace

] Add project to working sets New...

Select...

< Back Next >

Cancel

e Click on Tutorial from the list of projects in
the ‘Project Explorer’ on the left-hand side.

(=5 Timer PWM
=& Touch
=& Tutorial

R20UT4447EG0101 Rev. 1.01
Mar.31.20
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Renesas Solution Starter Kit for RX23W 3. Tutorial Project Workspace

34 Build Configurations and Debug Sessions

3.41 Build Configuration
The e? studio workspace will be created with two build configurations: ‘HardwareDebug’ and ‘Release’.

Release

This Build Mode has optimisation turned on, and provides little debug information. The C code execution may
appear to be out of order, due to the way the compiler optimises the code. This build configuration is intended
for final ROM-programmable code.

HardwareDebug
This Build Mode has all optimisation turned off, and provides full debug information. This is the best
configuration to use whilst developing code as C code execution will be linear.

e Click the top level ‘Tutorial’ folder again, and . - . .
then the arrow next to the build button s i WO v %, OF 0D @
(hammer icon) and select the @ >

X 1 HardwareDebug (Debug on hardware)
‘HardwareDebug’ option.

2 Release (Release - Mo Debug)

e e2studio will then build the code.

R20UT4447EG0101 Rev. 1.01 REN ESNS Page 12 of 23
Mar.31.20




Renesas Solution Starter Kit for RX23W 3. Tutorial Project Workspace

3.4.2 Debug Configuration

e Click the arrow next to the debug button (bug @% i@ g v
icon), as highlighted by the red circle. - o
Select ‘Debug Configurations’. (no launch history)
Debug As ¥
Debug Configurations...

Organize Favorites...

«  The ‘Debug Configurations’ dialog box wil

appear. C“Ck the Sma" arrow neXt tO the Create, manage, and run configurations
‘Renesas GDB Hardware Debugging’ option.

e The debug configurations for each project will EEL =
appear. Select the entry for the “Tutorial press the
Hal'dwareDebug’ Java Applet ~ = - Press the

Java Application
¥ - Pressthe

R Launch Group

[ Launch Group (Deprecated) b - Pressthe
Remote Java Application

~ [c7] Renesas GDB Hardware Debugging

[E7] Application HardwareDebug
[£7] Application Release Configure laun
[E7] Async_Serial HardwareDebug
[£7] Async_Serial Release
E Low_Power_Mode HardwareDebug
El Low_Power Mode Release
[£7] RTC HardwareDebug
[E7] RTC Release
[£7] System_BootLoader HardwareDebug
[E7] System BootLoader Release
[£7] System_BootLoader_Application HardwareDebug

- Edit or vie

[E7] System_BootLoader_Application Release
[E7] System_Input_Capture HardwareDebug
[£7] System_Input_Capture Release

[£7] Timer_PWM HardwareDebug

E Timer_PWM Release

[£7] Tutorial HardwareDebug

[£7] Tutorial Release

[E7] Renesas Simulator Debugging (RX, RL78) w
e The debug configurations control page will Bl Main 35 Debugger| b Stariup| % Saurce| I Commeon
then show for the Tutorial project. Change Debug hardware: | E2Lite(RX) | Target Device: | RSFs23Ws

the main tab to ‘Debugger’ and then select
‘Connection Settings’ on the secondary tab

GDB Settings  Connection Sefttings  Debug Tool Settings
v Clock

bar that appears. Main Clock Source HOCO v
Extal Frequency[MHz] 2.0000
i Permit Clock Source Change On Writing Intern: Yes w
o Thelre is no need to change lthe debggger Pt Gk S Chg 0
settings as they are preconfigured with the Emulztor (Auta)
: H “ Connection Type Fine
Tutorial project. Please check “Power Target o e P eyt 200
From The Emulator (MAX 200mA)” is “Yes”. (e poud erellope = v
i Refer to the RSSKRX23W User,s Manual for ” Pwl’?:weﬂargetFromThEEmulator(MAXZDGmA] Yes v
details of power supply configuration. Supply Vaage(V] =

~ CPU Operating Mode
Register Setting
Mode pin

Change startup bank

Note: e? studio will display a warning Startup bark
if you attempt to connect with an T
incorrect power supply setting.

¢ Click the ‘Debug’ button to continue.

e? studio will be connected to the debugger
and download the code to the target.

R20UT4447EG0101 Rev. 1.01 :{EN ESNS Page 13 of 23
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3. Tutorial Project Workspace

e Afirewall warning may be displayed for ‘e2-
server-gdb.exe’. Check the ‘Private
networks, such as my home or work network’
box and click ‘Allow access’.

e Auser account control dialog may be
displayed. Enter the administrator password
and click ‘Yes’.

™ Windows Security Alert

G Windows Firewall has blocked some features of this app

Windows Firewall has blocked some features of E2 Server GDB on all public, private and domain

networks.
@ Name:
Publisher: Renesas Electronics Europe Ltd
Path: C:'yenesas'e2_studio\debugcompyx\e2- server-gdb.exe

Allow E2 Server GDB to communicate on these networks:
[+] Domain networks, such as a workplace network

[Private networks, such as my home or work network

[[Public netwarks, such as those in airports and coffee shops (not recommended
because these networks often have little or no security)

What are the risks of allowing an app throudh a firewall?

E;éllow access Cancel

e After downloading the code a dialog box will
appear asking if you would like to switch to
the ‘Debug perspective’. Click ‘Remember
my decision’ to prevent this dialog box from
appearing in future, then click ‘Yes’.

e e? studio will load the new perspective, which
is optimised for debugging.

e’ Confirm Perspective Switch

I@.‘ This kind of launch is configured to open the Debug perspective when it suspends,
L ° 4
This Debug perspective is designed to suppert application debugging. It
incorporates views for displaying the debug stack, variables and breakpoint

management.

Do you want to open this perspective now?

Yes

=z
]

e To change back to the default ‘C/C++’
perspective, from the menu bar select
Window > Perspective >Open Perspective >
Other or click the Open Perspective button.

=

e The ‘Open Perspective’ dialog box will
appear. Click on the desired perspective to
select it then ‘OK’.

o Perspectives can also be switched with the
following shortcuts.

i) C/C++ %5 Debug

e The perspective should be 'Debug’, as it will
be needed in the next section.

? Open Perspective

BEiC/Cr+ (default);

"% Code Generator

% Debug

e Git

%’Ja\ra

E:?Ja\ra Browsing
EJJa\ra Type Hierarchy
(1) Planning

{5 Resource

= Scripting

£ Smart Configurator
B SVN Repository Exploring

éUTeam Synchronizing

3.5 Running the Tutorial

e Refer to the description.txt file in the doc folder of Tutorial project for instructions on how to configure the

RSSK and run the sample code.

e Once the code has been downloaded, click ‘Resume’ button ! to run the code to the main function. The
main function is set as the program entry point by default.

instruction in the main function.

e Click the ‘Resume’ button ™

in the ‘Debug’ perspective to run the rest of the code.

e ltis recommended that you run the entire tutorial demo first, before continuing to debug it.

R20UT4447EG0101 Rev. 1.01
Mar.31.20
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4. Reviewing the Tutorial Program

4. Reviewing the Tutorial Program

This section will look at each section of the tutorial code and basic debugging functionality in e? studio.

4.1 Program Initialization

Before the main program can run, the microcontroller must be configured. The following parts of the tutorial
program are used exclusively for initializing the RSSK device so that the main function can execute correctly.
The initialization code is run every time the device is reset via the reset switch or from a power cycle.

e Build and download the code as shown in
Section 3.4.

e On the Project Explorer tab expand the
‘Tutorial’ folder by clicking on the arrow
next to the folder icon, as highlighted by
the red circle.

5 Project Explorer i3 = <\"=l=|> |
== Application
=5 Async_Serial
=L Low_Power Mode
=% RTC
=% System_BootLoader
=% System_BootLoader_Application
=5 System_lnput_Capture
=5 Timer PWM

Touch
utorial [HardwareDebug]

e Click the arrow next to the ‘src’ folder to
show the source files.

e Expand the folder path 'smc_gen' ->
'r_bsp'->'board' -> 'generic_rx23w' as
shown and double click on the file
'hwsetup.c'.

v =5 Tutorial [H ardwareDebug]
;f;?' Binaries
[ Includes
v 2 sre
v = smc_gen
£ Config_CMTo
= Config_CMT1
(= Config_CMT2
= Config_ICU
= Config_PORT
= Cenfig_S12AD0
= Config_5CI2
= Config_SCla
= general
v = r_bsp
v (= board
v [ generic_m23w
[ hwsetup.c
hwsetup.h

o Breakpoints can be set by double clicking
at the left-hand edge of the source
window. On the line with instruction
‘R_Systeminit();’, double click next to the
vertical line to set a breakpoint.

Note: As an alternative, breakpoints may be
set in the C/C++ perspective by selecting a
line and using Run > Toggle Breakpoint.

96
181
182
1@
16
1@

o}

® * Function name: peripheral modules_enable[]

static void peripheral_modules enable(void)

{
#if BSP_CFG_CLKOUT_RF_MAIN == &

/* Add code here to enable peripherals used by the application */

#if BSP_CFG_CONFIGURATOR_SELECT == 1

/* smart Configurater initialization function */

R_Systeminit();
#endif
#endif

} /* End of function peripheral_modules_enable() */

R20UT4447EG0101 Rev. 1.01
Mar.31.20
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4. Reviewing the Tutorial Program

e Click the ‘Resume’ button in the Debug
perspective (or press [F8]) to run the code
up to this breakpoint.

ll

Note: The program counter is indicated by the
blue arrow next to the breakpoint.

7 fffeldse |

®* Function name: peripheral_modules_enable[]
= static void peripheral_modules_enable(void)

{
= #if BSP_CFG_CLKOUT_RF_MAIN == 8
/* Add code here to enable peripherals used by the application */
~ #if BSP_CFG_CONFIGURATOR_SELECT == 1

/* Smart Configuratgr initialization function */
R_Systeminit();

#endif

#endif

} /* End of function peripheral_modules_enable() */

e Click the ‘Step Into’ button (or press [F5]),
to step into the ‘R_Systeminit’ function.

=L

e The ‘R_Systeminit’ function calls several
initialization functions which configure the
MCU for normal operation. This includes
input/output ports, and system clocks.

e The user can step through all the
initialization code by clicking the ‘Step
Into’ icon and reading the code however
for the purpose of this manual, it will be
skipped.

e Click the ‘Resume’ button, to run the code
up to the main function.

0

FifBlce3

fffelces

fffglcfl
Fif8lcfs

fifglcfa

fffalcfe
fifsldez
Fifa1des
fffgidea
Fifaldee
fffaldiz
fifaldie
fifeldla

fffaldle

fffgidaf
fifa1d3e

Fifaldsd

- koid R_Systeminit(void)

/* Enable writing to registers related to operating modes, LPC, CGC, software reset and LVD */
SYSTEM.PRCR.WORD = @xAS@FU;

/* Enable writing to MPC pin function control registers
MPC.PWPR.BIT.BOWI = @U;
MPC.PWPR.BIT.PFSWE = 1U;

/* Initialize clocks settings */
R_CGC_Create();

/* Set peripheral settings */

/* Register undefined interrupt
R_BSP_Interrupthrite(BSP_INT_SRC_UNDEFINED_INTERRUPT, (bsp_int_cb_t)r_undefined exception);
/* Disable writing to MPC pin function control registers */

MPC.PWPR.BIT.PFSWE = @U;

MPC.PWPR.BIT.BOWI = 1U;

/* Enable protection */
SYSTEM.PRCR.WORD = @xA588U;

For further details regarding hardware configuration, please refer to ‘Renesas Solution Starter Kit for RX23W
User’s Manual’ and ‘RX23W Group User’'s Manual: Hardware’.

R20UT4447EG0101 Rev. 1.01
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Renesas Solution Starter Kit for RX23W 4. Reviewing the Tutorial Program

4.2 Main Functions

This section will look at the program code called from within the main function, and how it works. It is
necessary to connect the RSSK USB Serial Connector(USBCNO) to a PC USB port and open a terminal
emulation program, such as Tera Term, with the settings:

Baud Rate: 19200,

Data Length: 8, Parity Bit: None, Stop Bit: 1, Flow Control: None
For information on installation of the RSSK virtual COM port driver, refer to the file ‘description.txt’ in the doc
folder of the e? studio Tutorial project.

The USB serial driver made by FTDI is required for USB serial communication. Please download from the
URL below. Please contact FTDI for installation method of USB serial driver and questions.
https://www.ftdichip.com/Drivers/D2XX.htm

8086 = void main(void)|

¢ Right click the
‘R_Config_SCI8_ Serial_Receive’ function
call and select ‘Run to Line’ to execute the
program up to this line. The ‘R_LCD_Init’
function call enables and configures the

2 /* Initialize the switch module */

frfgesfs R_SWITCH Tnit();
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCallback(cb_switch_press);

/* Initialize the debug LCD */
R_LCD_Init();

0

fffseges

LCD panel, and ‘R_LCD_Display’ will
write “RSSKRX23W Tutorial Press Any
Switch” onto the LCD.

fffaagea

w

fffsesle

fffaegzz

fffaagze

WM @MW oY

fffaegsa

In

/* Displays the applicatio
Casting for use as char
R_LCD _Display(@, (uintd_t

/* Casting for use as char
R_LCD Display(l, (uintd_t

/* Casting for use as char
R_LCD Display(2, (uintd_t

n name on the debug LCD.
acters. */
*)" RSSKRX23W");

acters. */
*)" Tutorial ");

acters. */
*)" Press Any Switch ");

/* Start the A/D converter */

R_Config S12AD@_Start();

/* Set up SCI8 receive buf
R_Config_SCI8_Serial_Recei

fer and callback function */
ve((uint8_t *)&g rx_char, 1);

Set a breakpoint on the
‘R_Config_SCI8_Start’ function call by
double-clicking in the breakpoint column.

Click the ‘Step Into’ button to step into the
‘R_Config_SCI8_ Serial_Receive’ function.

L

5 fffeeas4

fffaeoase

/* Set up SCI8 receive bu
R_Config SCI8_Serial Rece

ffer and callback function */
ive((uint3_t *)&g rx_char, 1);

* Enable SCI8 operations */

R_Config SCIB Start();

The program counter should now move
into the ‘R_Config_SCI8_Serial_Receive’
function definition. This function is an API
function provided by the Smart
Configurator. It sets up the SCI interrupt
handler code to receive a specified
number of bytes into a receive buffer.
Once the specified number of bytes has
been received, the interrupt handler code
calls a callback function as shown later on
in this section.

For full details on how to configure a
project using Smart Configurator refer to
the Smart Configurator Tutorial Manual.

Click the ‘Resume’ button to resume
program execution.

0

o fffalbes

MD_STATUS R_Config SCI8 Serial Receive(uints t * const rx_buf, uintls t rx_num)

{
|

MD_STATUS status = MD_OK;

if (1U > rx_num)

{
}

else

{

status = MD_ARGERROR;

g_sciB_rx_count = @U;
g_scis_rx_length = rx_num;

gp_sciB_rx_address = rx_buf;

SCI8.SCR.BIT.RIE = 1U;
5CI8.5CR.BIT.RE = 1U;
}

return (status);

R20UT4447EG0101 Rev. 1.01
Mar.31.20
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4. Reviewing the Tutorial Program

e The program counter should come to a halt
at the ‘R_Config_SCI8_Start’ function.

e Step over the function by clicking the ‘Step
Over’ button. Alternatively, press [F6].

el
-

The ‘R_Config_SCI8_Start’ function enables
the UART interrupts. The program then
proceeds to the main while(1U) loop. The code
inside the loop waits for user input from either
the SCI or RSSK switches, and then performs
an A/D conversion.

/* Set up SCI8 receive buffer and callback functicn */
fffaeass R_Config SCI8 Serial Receive((uintd_t *)&g rx_char, 1);

/* Enable 5CI8 operations */
R_Config SCIB Start();

e Locate the function call to ‘lcd_display_adc’
inside the while loop.

e Set a breakpoint on the ‘lcd_display_adc’

function call by double-clicking in the break
point column.

= while (1U)
uintl6_t adc_result;

/* Wait for user requested A/D conversion flag to

5 fffse98a = if (TRUE == g_adc_trigger)
/* Call the function te perform an A/D conver:
fffeeoaa adc_result = get_ade();
/* Display the result on the LCD */
fffees49 lcd_display_adc(adc_result);

e In the Project Explorer pane, locate the file
‘Config_SCI8 user.c’ and double-click to
open the source file. Scroll down to the
function
‘r_Config_SCI8_callback_receiveend'.

v == Tutorial [HardwareDebug]
91'5? Binaries
B Includes
v 2 src
W == sMC_gen
= Config_CMTO
= Config_CMT1
= Config_CMT2
= Config_ICU
= Config_PORT
7= Config_$12AD0
= Config_sC2
v = Cenfig_SCla
[ Config_5CI8 user.c
[ Config_sClg.c
[k Config_5Cla.h
== general

e Set a breakpoint on the line of code inside
the ‘r_Config_SCI8_callback_receiveend’
function as shown opposite.

ffcelc54 = static void r_Config SCI6_callback receiveend(void)
/* Start user code for r_Config_SCI6_callback_receiveend. Do not

7 /* Check the contents of g_rx_char */
ffcolc56 © if ({'c’ == g_rx_char) || ('C’ == g_rx_char}}

¢ Continue to execute the program by clicking o FFcoicTb ! e - e,
the ‘Resume’ button. !
/* Set up SCI6 receive buffer and callback function again */
ffcelcss R_Config SCI6_Serial_Receive((uint3_t *)&g_rx_char, 1);
I;IP * End user code. Do not edit comment generated here */
¥
R20UT4447EG0101 Rev. 1.01 RENESAS Page 18 of 23
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Renesas Solution Starter Kit for RX23W 4. Reviewing the Tutorial Program

/* Check the contents of g_rx_char */

¢ In the terminal emulation window, press the /* Check X -
s if (('c' == g_rx_char) || ('C' == g_rx_char)})

‘c’ button on the keyboard.

e The program will halt at the breakpoint in
the r_Config_SCI8 callback_receiveend’
function as shown opposite. Remove the
breakpoint by double-clicking on the
breakpoint column.

g adc_trigger = TRUE;
h

/* Display the result on the LCD */

e Continue to execute the program by clicking Ffcongse lcd display_ade(adc_result);
the ‘Resume’ button. 3 /* Increment the adc count and display
4 ffceea71 = if (16 == (++gs_adc_count))
UF’ : ffceeoss : gs_adc_count = @;
3 ffc@aasc led_display count(gs_adc_count);

e The program will halt at the breakpoint in
the main while loop.

¢ Remove the breakpoint by double-clicking
on the breakpoint column. Continue to
execute the program by clicking the
‘Resume’ button.

Ub

The program proceeds to display the result of the A/D conversion on the LCD and in the terminal window. In
addition, the running count of A/D conversions performed is displayed in binary form using LEDs 0-3 on the
RSSK. Adjust the potentiometer and press SW1 or SW2 on the RSSK and an additional A/D conversion will
be performed.

e Press the ‘Suspend’ button to halt program

execution. uu
o change back o e deraut G0+ | I

perspective, from the menu bar select Window  Help

Window > Perspective >Open Perspective New Window -/ -BIBiN| D E N DR

> ‘C/C++7. Editor » -
Appearance 5 Cuick Access
Show View N es @g Breakpoints (3 dules X
Perspective > Open Perspective ? E C/C++
Mavigation > Custemize Perspective... %J EE

) :
- & Java Browsing
#7 Refresh Debug Views Save Perspective As...

Preferences Reset Perspective... Other...

Setup Views For Device »

Close Perspective

Close All Perspectives

e Alternatively, click on the ‘C/C++’ button in

the top right corner of the screen, as shown m |§"§ ped

opposite.

e This is the extent of the tutorial code.

For further details regarding hardware configuration, please refer to ‘Renesas Solution Starter Kit for RX23W User's
Manual’ and ‘RX23W Group User’'s Manual: Hardware’.

The E2 emulator Lite features an advanced logic-based event point trigger system, and full instruction on its use is outside
the scope of this tutorial. For further details, please refer to the E2 Emulator Lite User’s Manual.
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5. Additional Information

Technical Support

the help file by opening e? studio, then ,

selecting Help > Help Contents from the | |"indew Help

menu bar. iga) Welcome

(7] Help Contents

% Search

| i Show Contextual Help

Parts of the sample code provided with the RSSKRX23W can be reproduced using the Smart Configurator
tool. Smart Configurator is included as a plug in with e? studio.

Source files and functions generated by Smart Configurator are prefixed with r ’ and ‘R_’ or ‘Config_’,
respectively.

For information about the RX23W Group microcontrollers refer to ‘RX23W Group User’s Manual: Hardware'.
For information about the RX assembly language, refer to ‘RX Family User’s Manual: Software’.

Technical Contact Details

Please refer to the contact details listed in section 9 of the “Quick Start Guide”

General information on Renesas Microcontrollers can be found on the Renesas website at:
https://www.renesas.com/

Trademarks
All brand or product names used in this manual are trademarks or registered trademarks of their respective
companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics
Europe GmbH.

© 2020 Renesas Electronics Europe GmbH. All rights reserved.
© 2020 Renesas Electronics Corporation. All rights reserved.
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